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Introduction:   
 

This document is written for CAN-8 VirtuaLab users who will be creating activities and 
authoring their content. 

 
After this workshop, participants should:  

• Be familiar with the CAN-8 interface and tools  

• Able to navigate through different menus  

• Identify and open a Planner 

• Add/remove/edit all item types 

• Have a detailed understanding of all lesson item types. 

• Chose the activity display mode 

• Understand how to make newly created activities available to students 

• Recognize the functions associated with the Planner and how to access them 
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I. Introduction to CAN-8  
A - The CAN-8 Tools for Teachers.  

 
CAN-8 is a Suite of 4 tools  

o The Planner: To create activities for students 
o The Player where the activities are displayed once they have been created 

and saved. This is the only tool the students can access. 
o The Tracker: to monitor users' progress 
o Some administrative tools such as class creation, student registration, 

activity reports.  
 
Important:  
- Specific functions are associated with each tool. When working in the Tracker, the 
Planner functions are disabled until the Planner is activated.  
 - The system administrator may have restricted your access to some of these tools. If 
such is the case, you will receive a notification when trying to access the restricted 
tool.    
 

B - Signing On to CAN-8 
 

Every CAN-8 user is assigned a unique User ID and password.  
 
To sign on to CAN-8: 
1. On your Windows desktop, double-click the CAN-8 icon. 
2. The CAN-8 Login window appears. The server field should already have the 

information pre-set.  
3. In the User ID field type your CAN-8 User ID. 
4. In the Password field type your CAN-8 password, and then click Login. 
5. The Instructor Menu appears on the CAN-8 desktop. 
  

C - The CAN-8 Interface   
 
The CAN-8 interface consists of:  

• three tool bars 
• a main menu  
• a work area.  

1. The Tool Bars:  
 
Tool bars are links to CAN-8 functions. There are 3 main tool bars:     
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The Menu Bar 
 

This bar is located in the upper part of the interface  It provides links to all tools and most 
functions related to these tools.  
 

 
 
Place your mouse over the "File" menu and left click to open the contextual menu.  
 

 

 
Tools and functions are listed in this menu.  
 
Note that some entries are greyed out.  
 
Greyed out or inactive links are functions 
that are not available in the interface you 
are currently working in.  
 
The function "Print" for example in this 
illustration is greyed out.  It will become 
active as soon as you display on the 
interface information that can be printed. 
The same applies to the links "Save" and 
"Abandon Changes"  

 

Alternatively, you can use Keyboard shortcuts to open these menus:  

1) Identify the underlined letter in the menu name (in the illustration above, the 
underlined letter in File is F 
2) Simultaneously press the keys ALT and F to open this menu 
3) The contextual menu will open. Identify the underlined letter in the sub-menu or link 
you want to open. For example "Create `". (The  ` following a menu entry indicates 
that Create is a submenu.  ) 
3) Press C to open the Create submenu  
4) Press C again to open the link Class  
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The Button Bar 
 

 
 
This bar contains the buttons related to recording or listening to audio. These buttons will 
only be activated in an interface where sound can be recorded or played. 
 

The Function Bar:  
 
Located on the left hand side of the interface.  
This bar offers shortcuts to the CAN-8 tools: Planner, Tracker, Player, and main menu.   
Similarly to the top menu bar, the icons in this bar are inactive if they do not apply to the 
menu entry selected.   
 
Active 
state 

Mouse 
over State

Greyed 
state Function 

 

N/A 

Shows or hides the main menu from any interface 
currently opened.  
This allows the user to open more than one Planner, 
Tracker or lesson at a time. This button is always in 
active mode. 

  

Clicking on this button opens the Player of the lesson 
selected.  
If the menu entry selected is an application or a submenu, 
this button is greyed out. It is only active when a lesson is 
selected in the main menu.  

  

Select a lesson in the main menu and then select this 
button to access the lesson's Tracker  
 
If the menu entry selected is an application or a submenu, 
this button is greyed out.  

  

Select this button to access a lesson's Planner. 
If the selected menu entry is a lesson, this button is 
shown as active. If the menu entry selected is an 
application or a submenu, this button is greyed out.  

 

 

N/A 
Pressing this button will bring the SV phone interface. 
The instructor can then either call an online student or 
broadcast to all online users.  
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Important note to remember: 
If a link to a function (either a menu link, an icon or a button) is inactive, it indicates that 
these functions are not available in the interface currently displayed.    

2. The Main Menu  
 
Displays the list of lessons and accessible system functions in the form of a treeview.  
This menu can be retrieved at any time and from any CAN-8 interface (Player, Planner 
and Tracker) by clicking on its icon in the tool bar.  

 

 
1. Left click on the menu button once to display the main menu 
2. Left click on this button a second time to hide it.  

 
The menu presents a list of choices (such as internal administrative functions, lessons, 
media or internet links) nested within submenus and recognizable by their icon: 
For the purpose of this Planner training session we will be concentrating on the following 
icons  
  
Icon Type Description 

 
 Teaching     
Activity 

 
This is the only activity type that can be authored and monitored.   
The function icons in the Tool bar will highlight as soon as this link 
is selected in the menu.  

 
Submenu - 
closed  

Used to organize the CAN-8 system or the lessons in a tree structure 
and to simplify the menu display. 
Submenus can be nested inside other menus. When a submenu is 
selected, the Tool Bar items are greyed out as a menu can neither be 
authored nor monitored. Click on the + in front of this entry to expand 
it and view its content.  

 
Submenu - 
expanded  

This menu is expanded. When expanded, the instructor can view and 
access all links.   
Click on the - sign in front to hide its content.  

 
The submenu can be closed or opened. When closed, the items nested in that menu are 
hidden. The closed submenu is preceded by a "+" character.  
 

1. Left click on this "+ "sign to open and display the content of the submenu. 
2. The menu icon is replaced by the "expanded menu" icon.  This one is preceded by 

a "-" character.  
3. Left click on the "-" character to close this submenu.  
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The illustrations below show 4 layers of nested submenus - In order to access the lesson 
KAPITEL 5 you must first open all these menus one by one. 
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The submenu can be closed or opened. When closed, the items nested in that menu are 
hidden. The closed submenu is preceded by a + character. Left click on this + sign to 
open and display the content of the submenu.  
 
NOTE: The Planner icon will remain greyed out until a teaching activity type is selected 
in the menu    

II. Starting a Planner  
1. Who to Contact?  

Only the user with the MASTER ID can create entries in the main menu.  
If you wish to add an activity in the menu, you must contact that person and provide the 
title of the activity. Once the entry is in the menu, you can add the content.  

2. Opening the Activity in Authoring Mode:  
 
Authoring (adding content /exercises) is done from the Planner.  
To start a Planner: 
 
1) Navigate through the menu 
2) Left click once on the activity title 
3) Left click on the Planner icon -----------> 

 
 
 

3. Making the New Activity Available to Students. 
 
An activity is available to the students as soon as: 
 

• It is located in a part of the menu accessible by students 
You may wish to take the time to develop an activity before making it available to the 
students. In this case, ask to have your new activity created in the instructor's menu.  
Once the lesson is ready, you can ask the person with the MASTER ID to move your 
activity to the students’ menu. 
  

• It has been saved 
While you are working in the Planner, everything is done on your workstation.  
In order for other users to access it, your work has to be available on the server; you 
must therefore save it.  
Steps to save a Planner are detailed in section "VI- Saving your work" below.  
  

• It includes exercises with content 
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Empty exercises do not show in the students program. You can have a Planner with a full 
menu containing items, as long as these items do not have content, the Planner is 
considered empty.  
 
If for design purpose you wish to present an empty exercise to the student, you must at 
least include a "space" character in the text area.   
  

4. Function Tabs 
 
As soon as you start an activity a corresponding tab will appear in the tab bar.  

Up to 7 tabs can be simultaneously opened.  
  

  

A tab conveys three types of information: 
 

• The activity title; it is placed in the center of the tab.  
• The function the activity is opened with. The icon to the left side of the tab 

indicates whether the lesson is opened in  
o a Player, 
o a Planner or  
o a   Tracker. 
     

• The state of the tab (active or inactive):  
o A grey tab is an inactive tab. The activity is opened but not displayed.  
o The blue tab is the active tab, and corresponds to the interface that is being 

displayed.  
 

In your menu:  
 

1. Navigate through the menu 
2. Left click once on the activity title 
3. Left click on the Planner button (left tool bar) 
4. The tab should be blue, display the activity title and the Planner icon 
5. Next click on the Tracker button (left tool bar). A second tab appears with the 

same lesson title, but with a tracker icon.  
6. Because it is the last click you did, this tab is blue. It is the function displayed on 

your monitor screen or "active function".  
7. Left click on the grey tab. It becomes blue, and the interface displayed is now the 

Planner.  

Remember that depending on which tab is active, some of the top menu options will be 
greyed out.    
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To exit any of the tabs,  
 

1. Click on the tab to select it.  It will highlight blue.  

2.    Select the exit icon at the extreme right of the tab bar.  
3. These steps have to be repeated for each tab.  

III.  Adding Items  
 
Creating an activity consists in 
 
1 - Adding items (exercises) in the menu from the list of templates available 
2 - Adding content such as text, audio and graphics to these items 

1. Creating Items:  
1. Right click in the tree menu - a contextual menu appears.  

 

 

2. Left click once on New. This will open another drop down menu.  
3. In the list presented, left click on "Teaching Item".  
4. An item Named "New Item" is added to the menu. 

 

5. Type in the title "First Item" and press the ENTER key on your keyboard 
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6. Right click below this item 
7. A black horizontal "insertion cursor" will appear.  
 

 
 

8. Left click once on NEW, then once on Teaching Item 
9. Then type in "third item" as the title of the newly created teaching item.  

You now have: 

 

2. Inserting Items  
Next we are going to insert an item named "second item" between the 2 existing items.  
 

1. To insert item, right click once beneath "first item". The Insertion cursor should 
be between "first item" and "third item" as illustrated below 

 

 
 

2. Left click on "New" and on "teaching item" then type in the title "second item".  
 
When inserting items in an existing menu, make sure the insertion cursor is where you 
want the new item. 
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3. Moving Items:  
Note:  
You cannot move an item currently open for editing. You must first close the item or 

you will receive an error message advising you to close it and to try again.  

1. Next right click below "second item", left click on "New" then on "Teaching 
item" 

2. Name this item "fourth item"  
 
To move this item at the end of the menu, you can:  

1. drag/drop: 
• Left click on the item but do not release the mouse button 
• While holding the mouse button pressed, slide the item in the 

desired location. The insertion cursor will show you where the 
item will be dropped.  

• Once you have the cursor in the location you want, simply release 
the mouse button and the item will be moved.  

 
2. cut and paste:   

• Left click once on "fourth item" to select it. The name is 
highlighted blue.  

• Right click to get the contextual menu 
• Left click on "Cut" 
• Next right click between "first item" and "second item". Make sure 

the insertion cursor is where you want to place this item.  
• Left click on "Paste".   

IV. Working with Items.  
 
To add content to an item, you must first open its interface.  
 
Note that you can have up to 8 items opened simultaneously. It is therefore necessary to 
be able to identify which item you are currently working in.  
 
To open an item, simply double click on its icon in the Planner menu.  

1. Double click on "first item" 
2. Double click on "second item" 
3. Double click on "third item" 
4. Double click on "fourth item" 
5. 4 item tabs are now present in the Planner:  
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As for the function tabs , exercice  tabs convey three types of information: the type of the 
exercise, indicated by its icon , the title of the item, and its status (active or inactive) 
indicated by the tab color. Inactive exercice tabs, like inactive function tabs, are grey. The 
active tab is orange to differentiate it from a function tab. 
 
The orange tab corresponds to the item currently being edited, and in the illustration 
above, it is the 4th tab.  
 

6. Left click on the tab titled "first item". It is now highlighted orange.  
7. Left click on the white text area and type first item.  
8. Left click on the tab titled "second item". It is now highlighted orange.  
9. Left click on the white text area and type "second item". 
10. Do the same steps for the two other tabs.  
11. Now click on any of the tabs. Notice that the one that is orange is the one that is 

displayed on your screen. The title matches the text you previously entered.   
 
NOTE:  
You will not be able to copy/paste or move an item that is currently being edited 
(opened). You will first have to save it and close it. Closing your item will automatically 
save it.   
 
To close an item: 

1. Click on its tab to activate it (highlighted orange).  
2. Select the "X" at the right end side of the item tab area.  
3. Repeat these 2 steps for each item.  

 

V. Adding Content to the Exercises  
1. Working with Audio 

Sound can be added in most of the available items, but will be displayed or will behave 
differently depending on the item type. 

To add audio in CAN-8, you can:  

• Record your voice using a microphone.  
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• Import audio files using the import function.  

• Drag/Drop audio files into an item in the Planner.  

• Copy/Paste or Cut/Paste sound from a file or from a CAN-8 item  

• Cut some audio from a CAN-8 item and paste the clip into another item.  

NOTE:  
1. The maximum length for a recording or an audio file in an item is 40 minutes.  

2. You can import .wav, .mp3 and certain .wma audio files. The .wav audio format 
must be PCM at 44.1, 22.5 or 11.25 KHz. 

3. Native CDA files as found on regular audio CD must be first changed to wav or 
mp3 format.  

(1) Recording Audio  
 

1. In the menu, double click on "first item" to open it. 

4. You will see an orange tab with the title of the item and the same icon that 
precedes the title in the menu.  

5. The audio graph is located in the lower part of the interface. Right click on the 
record button and start recording your voice.  

 
6. Click on the pause button to stop the recording.   

  
7. To listen to your recording, click on the green graph or on the playback button 

 
8. Click again on the record button and record your voice again. Note that the new 

recording is appended to the previous one.  

(2) Importing Audio  
 
To import audio, you must have audio files ready in a format supported by CAN-8.  

1. In the menu, double click on "second item" to open it. 

2. You will see an orange tab with the title of the item and the same icon that 
precedes this item in the menu. 

3. In the top menu, select File >Import > Sound 
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4. Select the drive where the audio files are located and click on the file named 
import.wav then on "Open".  If you see an empty list where your file should be 
listed, try changing the “type” from Wave to MP3 in the type selector 

5. The audio will load in the audio player.  

6. You can click on the graph or on the playback button to listen to the audio.  

 

Note:  

You can click on the record button to add audio or you can import a second file. The 
added audio will be appended to the first one.  
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(3) Drag/Drop 

You may use any of the 2 methods below:  

1) If you can tile several windows on your desktop,  
 

 

• Locate the file you wish to import into CAN-8.  
• Left click once on it to select it - do not release the mouse button.  
• While holding the button down, move the mouse cursor on to the item's sound 

graph.  
• Release the mouse button to drop the file.  

2) Alternatively, if you cannot tile your windows,  

• Locate the file you wish to import into CAN-8.  
• Click once on it to select it - do not release the mouse button.  
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• Move the mouse cursor so that it is on top of the CAN-8 icon showing in your 
task bar.  

 
• Hold it there for a few seconds - the CAN-8 interface will appear.  
• Without releasing the mouse button, move the mouse cursor so that it is on top of 

the volume graph.  
• Once the location has been selected, release the mouse button to drop the audio 

file.  

(4) Copy or Cut/Paste 

The copy/paste and cut/paste functions can also be used to add audio in a Planner item.  

• From an existing disk file:  
• Locate the file copy.wav your drive, then right click on it to get the contextual 

menu, or left click once on it and select the EDIT > Copy option in the menu bar.  
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• Place your mouse over the volume graph window in CAN-8. 

 
• Right click and select PASTE in the popup menu, or select EDIT > PASTE in 

the menu bar of the CAN-8 interface.  
• The green audio graph will appear.  

(5) Deleting Audio 
If you wish to remove the audio from an exercise: 

1. Double click on the exercise icon in the menu to display it. (Make sure the 
corresponding tab is orange)  

2. In the top menu, click on Edit > Clear > Sound 
 
The audio is removed from the item.  

(6) Editing Audio 
The audio is edited using the volume display and the mouse. The primary method of 
editing audio is to remove unwanted parts, or to move sections of audio.   
 

• To delete part of the audio:  
1. Locate in the volume graph the part of the sound you wish to remove. You can 

locate it visually, or you can use the counter situated at the bottom right of the 
volume graph.  

2. Left click and hold down the mouse button at the beginning of the section to be 
removed, and then drag the mouse across the volume graph till the end of the 
section, leaving behind a darkened area. This area marks the sound to be 
removed. The sound to keep remains in bright green.  

 
3. Delete that section using the DEL key of the keyboard, or the Snip option under 

EDIT in the menu bar. The dark green section of the sound will be removed.  
 
When possible the sound should be cut at quiet parts indicated by an area in the 
graph with the lowest possible green bar height. If the sound is cut during loud 
sections, clicking sounds may result during playback where the remaining parts 
joined.  
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• To move part of the sound to a different area:  

1. Locate in the volume graph the part of the sound you wish to move  
2. Left click and hold down the mouse button at the beginning of the section to be 

removed, and then drag the mouse across the volume graph till the end of the 
section, leaving behind a darkened area. Release the mouse button when the area 
is selected.  

 

3. Left click and hold the mouse button pressed on the dark green area of the audio 
4. Move the mouse cursor to the area you wish to move the audio to and release the 

mouse button.  

As before, the result will sound better if you select and drop the audio between 2 
"silences".  

• In some cases, the changes made to the sound are incorrect.  

To remove the last change, select EDIT > Undo in the top menu.  

2. Adding Text  
As for the audio, there are several ways to add text to your items. You can 

• Type with the keyboard or one of the virtual keyboards.  
• Import from a text file  
• Drag and drop text  
• Copy paste text  

(1) Using the Keyboard:  
1. Click on the white text area to place your text cursor.  
2. Type your text.  

 
To accent the characters:  

1. Right click in front of the character to accent,  
2. Select Accent in the contextual menu,  
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3. Click on the accented rendition of the character.   

 
Alternative method: 
 

1. Type the character to accentuate 
2. Press CRTL + a on the keyboard to cycle through the various accented 

alternatives until you find the one desired.  

 

(2) Importing Text from a File 
 

1. Double click on the item to open it.  
2. Click on the white text area to place the cursor 
3. Select FILE > IMPORT > TEXT in the top menu 
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(3) Drag/Drop Text  

1. Open the document or web page you want to copy some text from,  
2. Drag the mouse over the text while holding the left mouse button to select it, and 

then release the mouse button. Selected text will be highlighted.  
3. Place the mouse on the selected text area,  
4. Press the left mouse button again and hold it then move the mouse pointer to 

where you want to drop the text in your CAN-8 exercise.  
5. Release the mouse button where you wish to place the text.  

(4) Copy-Cut/Paste 

1. Open the document or web page you want to copy some text from,  
2. Drag the mouse over the text while holding the left mouse button to select it, and 

then release the button.  Selected text will be highlighted.  
3. Right click on the selected text and select COPY or go to EDIT > COPY in the 

top menu.  
4. Click on the text area in CAN-8 and either right click and select PASTE or left 

click on EDIT > PASTE in the top menu.    

You can also use CTRL + C to copy selected text and CTRL + V to paste the copied 
text in CAN-8.  

3. Adding Graphics  
The graphic must be a JPG, BMP or a GIF and is restricted to a maximum size of 320 
pixels horizontally and 240 vertically. Images sized 320X240 will display entirely, larger 
sizes will be cropped to the top corner.  

(1) Using Copy/Paste 

An image can be copied then pasted from either a file on the hard drive, on a removable 
data storage device, or from a browser.  

1. Double click on your item to open it.  
2. Locate the graphic you would like to place in your item.  
3. Right click on it and select Copy in the contextual menu.  
4. In the CAN-8 interface, select the item you wish to paste the image in by having it 

displayed on the screen  
5. Right click on the displayed item and select Paste from the popup menu.  

Alternative methods for copy/paste can be used, such as: 

• EDIT > COPY in your browser, or your explorer menu bar, then EDIT> PASTE 
in CAN-8.  

• CTRL + C on your keyboard to select the image and CTRL + V to paste it in 
your other item.  
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(2) Using Drag/Drop  
 

Drag drop from a hard drive or USB storage key or from a browser (Note that some 
websites may not allow you to use the drag/drop function. When attempting to drag an 
image from such a site, you will only get the URL.)  

1. Double click on the CAN- 8 item to open it. 
2. Left click and hold the mouse button down on the image you wish to drop in the 

exercise   
3. Drag the image over the CAN-8 exercise 
4. Release the button.  

Finding an image of the correct size in Google image:  

1. Open your browser 
2. Type in https://images.google.com/ 
3. In the search bar, type: clipart 320 X 240 - The images will be of the correct 

format or very close to it.  

(3)  Importing an Image:  
 

1) Double click on the item to open it.  
2) Select FILE > IMPORT > image in the top menu bar. 
3) Locate and select the image file name in the import window then select open.  
4) The image will appear in CAN-8.  
Depending on the item type, the image will be displayed on the left or above the text.   

4. Synchronizing Text and Sound.  
 
When text and audio are synchronized, as the sound plays, the corresponding words in 
the text window highlight in turn.  
Likewise, clicking on the highlighted text plays the corresponding sound.   
 

1. Create a new "Teaching item" in the Planner's menu and name it "Sync" 
2. Type in the following:  

 Days of the week 
 Monday 
 Tuesday 
 Wednesday  
 Etc.  

3. Record what you just typed.  
4. Listen to the audio and locate in the graph the sound you wish to synchronize, 

possibly by re-playing the audio until you can see where in the graph the word is 
located. The graph counter may be helpful to remember the exact part of the 
audio. 

5. In the text area, left click once in front of the word "Monday"  
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6. In the audio graph, Left click once in the audio graph where the word "Monday" 
starts. Do not play the audio.   

7. Select TEXT > SYNC TO SOUND from the menu bar. The text will turn blue. 
8. Left click in front of the word Tuesday,  
9. Click in the audio graph click where the word Tuesday starts. 
10. Select TEXT > SYNC TO SOUND from the menu bar. This part of the text will 

turn blue. 
 Repeat these 3 steps for every day of the week.  

VI. Saving your Work 
Your work is automatically saved and sent to the server as soon as you exit the Planner.  
 
1) Before closing the Planner, close all your open items (press the X at the end of the 
orange tabs line until there are no more orange tabs). 
2) Close the Planner.  That is the blue tab with the name of your activity and the Planner 
icon. Press the X at the right end of the tab. 
Your lesson is now saved.  
 
To view your work just as the student will you can either: 

1. Click on the player icon in the left tool bar 
2. Double click on the title of your activity in the CAN-8 main menu.  

VII. Creating Different Item Types 
1. Lesson Items 

This table summarizes the types of lesson items you can create. More 
information about each is provided in the sections below. 

Note: Items shown with an asterisk (*) are marked by the computer. 
Use this Item Type: If you want students to: 

Introduction begin a section of the lesson  
Teaching  learn about a specific concept (without 

responding) 
Multiple Choice *  choose from a list of possible answers  
Fill-in-the-Blanks * fill in one or more missing words 
Example  record after listening to a model  
Verify  record before listening to a model 
Conversation simulate a conversation (in combination with an 

Example or Verify screen) 
Simultaneous  record at the same time as listening to a model  
Ask and Answer record an answer to an open-ended question 
Read read and record specific text 
Write type a written response 
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2. Introduction Items 
Can include:  Audio, image. No text. 
 

Use Introduction items when you want to: 
o Divide your lesson plan in sections 
o Provide instructions that will be played automatically when students begin a section 
 
A typical Introduction item might include copyrights, information related to the activity 
or to the items included in that section.  
 
Introduction items are the only items that can be left empty and are still displayed. In that 
case, their purpose is to create sections in an activity: 

 
 

The illustration above shows a lesson 
 plan divided in 3 sections. Grammar,  
Vocabulary, and a Test. These are 3  
Introduction items. ENG001 is the 
default introduction Item that has been 
given the class name. 

 
There  "+ "character in front of each 
Introduction item indicates that (hidden) 
items are included in that section. If you 
click on the + (expand the sections), you 
will be able to see these items, as 
illustrated on the right.  
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To create an Introduction item.  
1. In the Planner's menu, create a new item and select Introduction in the contextual 

menu.  

2. Name this item. If you want this item to be used as a section separator only, you do 
not need to do anything else.  

3. If you want a graphic to display as a background for the section, add an image. You 
can also add some audio.  

3. Teaching Items 
 
Teaching items can include sound, text, and either graphics or video. They cannot be left 
empty.  
 
Students cannot record or type answers in a teaching item. They can only read and/or 
listen to the information provided by the instructor. 
 
Use Teaching items when you want to: 

• explain a concept  
• post information, introductions, explanations, lists of words, etc. 

 
For example, a Teaching item could be used to present grammar rules or to explain what 
is expected from the students in the following exercises. It can also be used to present a 
text or an audio file that will be referred to in the next items.  
 
To create a Teaching lesson item: 

1. In the Planner's menu, create a new item and select Teaching item in the 
contextual menu.  

2. Double click on the item to open the template.  
3. Add the media you wish to include (audio, text, graphics).  

4. Multiple Choice Items 
Must include text  
Can include audio and graphics 
 
Use Multiple Choice items when you want students to choose the answer for a written or 
oral question among a list of possible text answers.   
 
CAN-8 automatically determines whether or not a student’s answer is correct. If a mark 
has been assigned in the Planner, the software will calculate the result.  
 
During a test if no mark has been assigned to a Multiple Choice item, it is treated as a 
practice question. In this case, the specified type of feedback is provided to the student. If 
a mark is assigned to it, then feedback is disabled. 
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To create a Multiple Choice lesson item: 
1. Open the Planner. Create a new item in the menu and select Multiple Choice.  
2. Name this item and double click to open it.  
3. Type in the question the student will have to answer.  
4. Insert a blank line below the question, and then type each possible choice on a 

separate line. 
            Ex:   
              
             Select the correct answer:   
             Jim likes to play with Sarah. 
              
             He likes to play with her. 
             She likes to play with him. 
             He likes to play with herself.  
             He likes to play with them.  
 
5. Position the cursor anywhere on the text for the first choice offered: 
            | He likes to play with her 
6. From the Text top menu choose Tag Answer. 

 
A red numbered box appears at the beginning of the line, indicating an incorrect 
answer. 

7. To indicate that it is the correct answer, from the Text menu choose Tag answer a 
second time and the box will turn green 

8. Repeat the steps 5 and 6 above for each wrong answer, add step 7 for the right 
answer.  

 
Multiple Choice in the instructor's 

window 
Multiple Choice as seen by the student.  

 
 

9. Selecting Tag Answer a third time will remove the selection box from the line.    
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Note:  
• You can tag more than one correct answer. The student however will only 

have to check one correct answer to get the full score.  
• By default, possible answers appear in random order when they are 

presented to students. (See illustration above) You can change this 
behavior in the properties of the item.  

• If you want to add text below the list of choices, you must disable the 
"random" option or that text will be randomized as well and may appear 
between choices.  

5. Fill-in-the-Blanks Items 
Must include text  
Can include sound and graphics. 
Use Fill-in-the-Blanks items when you want students to supply missing text. 
 
To create a Fill-in-the-Blanks item: 

1. Open the Planner. Create a new item in the menu and select "Fill In Item".  
2. Name this item and double click to open it.  
3. Type in the text or sentence the student will have to complete, including the 

word(s) that will be hidden.  
4. Select the text to hide:  
• For a single word,  

a. Position the cursor in front of the first letter of the word and left click,  
b. Select Tag Answer from the Text menu. 

• For two or more consecutive words or for part of a word 
a. Place the mouse cursor in front of the first word or letter,  
b. Click and hold the left mouse button and then drag it over to the last letter 

of the text to hide.  
c. Release the mouse button to make the selection.  
d. Select Tag Answer from the Text menu. 

5. The selected text will appear in white over a black background:  
 
Planner display 

 
 
Student display of the same exercise:  
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Note:  To reverse the process (unselect a word, punctuation, an extra space, or anything 
else that you have inadvertently marked as part of a blank),  

1. Select the text  
2. Select Normal from the Text menu. 

 

6. Example Items 
Must include sound,  
Can include text, and graphics 
 
Use Example items to play an example of speech to the students, which they are then 
expected to repeat in a student recording. In Student mode, the model voice graph is 
displayed above the student's graph bar. Students will be able to toggle between both 
graphs to listen and try to reproduce the oral sample. 
 
To create an Example item:  
 

1. Open the Planner. Create a new item in the menu and select "Example Item".  
2. Name this item and double click to open it.  
3. Record, import or paste the sample sound the student will hear and repeat. This 

can be your own voice or a digitalized audio file.  
Note:   
You can add text to this item:  
For beginners, type in the word or sentence to repeat.  
For a little more challenge, do not provide the text. 
  

7. Verify Items 
Must include audio and text 
May also include and graphics.    
 
Use Verify items when you want students to record their own voice and then compare 
their answer to a model afterwards.  
 
Here is an example of a Verify item dealing with the irregular past tense:  
 

1. Open the Planner. Create a new item in the menu and select "Verify Item".  
2. Name this item and double click to open it.  
3. Type in a question or the text or sentence the student will have to record.  
4. For example, type in What did you eat yesterday? [a banana] 
5. Record the correct answer:  I ate a banana. 

The student will have to read the question, record a response and then verify whether it is 
correct by listening to the model answer. The student cannot listen to the answer before 
recording a response. 
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8. Conversation Items 
Must include audio ONLY.   
Use Conversation items when you want to simulate a simple conversation.  They are used 
in combination with and appear on the Planner immediately before either an Example 
item or a Verify item. 
 
Note: Students will not see any text or graphic you include. 

Combining a Conversation Item with an Example Item 

Here is an example with a model answer: 
1. Open the Planner. Create a new item in the menu and select "Conversation Item".  
2. Name this item and double click to open it.  
3. Record the question What did you eat yesterday? 
4. Close the item 
5. Create a new item in the menu and select "Example item".  
6. Name this item and double click to open it.  
7. Type in: a banana 
8. Record the answer : I ate a banana 
9. Close the item 

 
These two items will be displayed in one screen only. The Conversation item will not 
show. Instead only the Example item will be displayed. Students will first hear the 
question included in the Conversation item. They then listen to the instructor's sample 
answer before recording their own.  

Combining a Conversation Item with a Verify Item 
1. Open the Planner. Create a new item in the menu and select "Conversation Item".  
2. Name this item and double click to open it.  
3. Record the question What did you eat yesterday? 
4. Close the item. 
5. Create a new item in the menu and select "Verify item".  
6. Name this item and double click to open it.  
7. Type in: a banana 
8. Record the answer : I ate a banana 
9. Close the item. 

 
As above, these 2 items will be displayed in one screen only. The Conversation item will 
not show. Students will first hear the question included in the Conversation item. They 
will then read the written prompt and use it to form an answer. Once their answer is 
recorded, they can compare it with the instructor's answer  
 
 
 

9. Ask and Answer Items 
Can contain text, audio, graphics:  



 

Page 32 of 40 

 
Use Ask and Answer items when you want to ask students open-ended 
questions to which they record their response.   

For example: 

�  “Tell me about yourself”  
� “Summarize the story you heard”  

� “What three things did you like about the story?” 

To create an Ask and Answer item: 
1. Open the Planner. Create a new item in the menu and select "Ask Item".  
2. Name this item and double click to open it.  
3. Record and/or type a question. 
4. Close the item.  

10. Simultaneous Items 
Must contain audio 
Can contain text and graphics.  
 
Use Simultaneous items when you want students to: 

• maintain an appropriate pace in the target language 

• practice translation from one language to another 
 

Simultaneous items play the sound only while the student is recording. Students cannot 
listen to the instructor's audio before recording.  After the recording is made, students can 
listen to their response and to the instructor’s audio.  

To create a Simultaneous lesson item: 
1. Open the Planner. Create a new item in the menu and select "Simultaneous Item".  
2. Name this item and double click to open it.  
3. Record or import the audio the student will work with 
4. Close the item. 
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11. Read Items 
Must contain text 
Can contain graphics 
Cannot contain audio or video.  
 
Use Read items when you want students to read and record text they see on the screen or 
to answer orally to a written open question related to a text provided.   

Read items are often used to evaluate student progress in learning pronunciation and 
reading comprehension. This can include the pronunciation of segmentals, but is 
especially useful for sustained practice of stress, rhythm and intonation. 

To create a Read item: 

1. Open the Planner. Create a new item in the menu and select "Read Item".  
2. Name this item and double click to open it.  
3. Type/import/paste a text paragraph.  
4. Describe if the student must read and record the paragraph, (emphasis on 

pronunciation or on sentence rhythm) or answer a question related to the 
paragraph: (Why do you think the author wrote this poem?  What mood did he 
intend to convey? Do you agree with the author?) 

5. Close the item. 

12. Write Items 
Can only include sound. 
 
Use Write items when you want students to type an answer to an oral stimulus. They can 
be especially useful for dictations.  

 
Students can print out their responses, or save them to a file. 

To create a Write lesson item: 
1. Open the Planner. Create a new item in the menu and select "Write Item".  
2. Name this item and double click to open it.  
3. Record or import audio. 
4. Add a question to the audio recorded to advise students of what they must do 

Example:  
 Type the following dictation; you can listen as many times as you want, you 
 can listen once only, you have x minutes to finish the dictation etc.  
 Listen to and resume the following story:   
 Listen to the following conversation - What information does that man ask for?   
5. Exit the item.  

 



 

Page 34 of 40 

VIII. Item options 
Item options only affect the item they have been set for. They are located in the 
Properties of the item.  
 
To access the item's Properties, in the Planner's menu:  

1. Left click once on the item to select to (Item title highlights blue)  
2. Right click on the same item.  
3. In the pop up menu, select Properties.  
4. The dialog will be displayed. 

 

While some fields are common to all item types, some are specific to some items.  

1 - All item types 

1. Item name:  
Type a new title for the item in this field. 
  

2. Type 
You can assign a new type to an existing item. Simply click on the radio button in front 
of the new type.  Text, audio and graphics are not affected by the type change, unless the 
new type has restrictions particular to that type: Changing an Example item to a Read 
item for example will remove the audio.  
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3. Marks  
This option is only available for items requiring a student answer. It is greyed out for 
Introduction, Teaching and Conversation Items.  

 

 
 
 
In the Item Mark field, in the right corner 
of the Properties box, select the mark the 
item will be scored out of. These marks are 
pre-defined by the system.  
_/8 means that this item will be scored out 
of 8 points. 

 

4. Play limit 
This option limits the number of times the student can listen to the audio included in the 
item during a test.  
 

 

There are 4 options available.  

• No limit is the default one. The 
student can listen to the audio in the 
item as many time as necessary  

• Once only limits the audio to one 
playback.  

Up to 2X and up to 3X limits the play 
back of the audio to 2 or 3 times 
(respectively) or less. 

Once the limit of playback times has been 
reached, the student can no longer listen to 
that audio for the remainder of test, even if 
the Back option is available and the student 
can open that item again. This option is 
reset every time the student starts the test 
again. 
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2 - Fill in the blanks options:  

1. Part Marks:  
This option is only available for Fill-in items. It is greyed out in the Properties of the 
other item types. 
 
Fill in the blank questions are scored by the computer   
By default, the score for this item type is assigned for all blanks. If one of the blanks is 
incorrect, the entire item is considered incorrect. The score assigned is 0.  
 
If however, the Part Marks option is checked, and there are several blanks in the question, 
each blank is scored on a fraction of the mark: For 2 blanks, each one is assigned 1/2 the 
mark assigned; if there are 3 blanks, a 1/3 of the mark is assigned for each blank.  
To make scoring more logical, assign an "out of" mark divisible by the number of blanks:  
ex chose _/9 if you have 3 blanks instead of _/8.   

2. Match case.  
This option is only available for Fill-in items only.  
 
By default, when answering a fill in the blank question, upper and lower case are 
considered the same and the answer will be marked correct if either case is used.  
It is however at certain times important that the exact upper and lower case characters be 
used to complete the answers. While this option is checked, correct answers will be case 
sensitive and must match exactly.   

3 - Multiple Choice Options  
This option is only available for Multiple Choice items only. It is greyed out in all other 
item types.  
To prevent memorization or copying of answers, the available choices in multiple choice 
questions are by default randomized. This means that each time a user enters the exercise, 
the same choices are displayed, but they will not always be displayed in the same order. 
Two students sitting side by side can be in the same exercise, yet would see the choices in 
a different order. 
 
To change this default and have the answers displayed in the exact order they were when 
the item was created, uncheck it in the item's Properties Box.  
 
NOTE:  
If you add text at the bottom of the list of possible choices, you will have to uncheck the 
random option or the text will also get randomized and may be displayed between 2 
items.   
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IX. Planner Options  
 
Unlike item options that only affect one item at a time, Planner options apply to the entire 
Planner and therefore affect every item belonging to that Planner.  
To access these options, you must: 
 

1. Select a lesson in the main menu  
2. Open the Planner for that lesson  
3. Select OPTIONS -> Planner in the top menu bar.  

 
NOTE:  
These options are only available when the Planner is displayed on the screen.  
 

1 - Slow Enable  
 
This option is selected by default. 
It allows the students to see the Speed Control Slider on the volume graph. The student 
can then listen to the audio at a slower or faster speed.  
 
To remove this option, click on the Slow Enabled menu entry to uncheck it. 

2 - Legacy Window Size  
This option provides screen size compatibility with lesson created in previous versions of 
CAN-8.  
 
It reduces the item display area to the size that the lesson was originally designed for, 
thus keeping the text format as originally planned if hard returns were not used to create 
the item.  
 
This option should never be used on new lessons. 
If a lesson is displayed in Legacy format and you uncheck it, the lesson will now display 
on a much larger area than the area it was designed for. You will have to go through the 
lesson at least once to make sure the format of the text is readable. Items with 
synchronized text will have to be re-synchronized in most cases. 

3 - Item Selection 

Determines how the items are presented to the student in a lesson.  
There are 4 possible settings:  

 



 

Page 38 of 40 

1. Menu 
This is the default mode when a lesson in the Planner is created.  
 
In this mode, the tree menu is displayed when the students enter the lesson (see 
illustration). The students can view and select items in the order they chose, as many 
times as they need.  
 
In this mode, when the lesson is set to Test, students can re-start the test and re-do the 
items as many times as they want to.  

2. Sequence 
 
If Sequence is checked, the treeview menu is hidden. The lesson is displayed on the 
entire interface, including the area where the menu usually resides.  
 
The items in the lesson are presented to the students in sequence and in the order they are 
in the Planner, until the end of the lesson is reached. The student can go back and forth, 
but can only go through the items in the order presented.  
 
Note: 

• When the lesson is set to Sequence and Test mode, once the students have 
answered all the questions, they can no longer access the lesson nor re-do the 
items until their answers are deleted from the tracker. In practice mode the 
student who then reaches the end of the lesson can start again from the beginning  

• In practice or test mode, if the student does not answer the first few questions, 
then records an answer in a following question, and exits before the end of the 
lesson is reached, only the items that follow the last answer recorded will be 
presented to the student when he signs back in.  

3. Random 
As in Sequence mode, the tree menu is hidden when the lesson is set to random mode.  
 
Random mode changes the order in which the questions are presented to the students. 
This prevents students who are doing a test in a group setting from easily copying work 
from other students nearby. It is also useful to prevent students memorizing the order of 
the answers if an activity is presented regularly.  
 
Note:  

• If the activity is divided into sections  (i.e.: grammar, vocabulary etc.), each 
separated by an Introduction item, only the exercises within the first section will 
be presented randomly until they are all answered; Once the first section is 
finished, only then will the exercises of the second section be presented, again in a 
random order.   

• Conversation and Teaching items always will appear before the randomly 
selected item they are paired with.  
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4. Enable Back Button 
 
This option enables students to return to previous items they may have left unanswered or 
to revise their answer.  
 
The "Back" option is on by default.  
 
Deselecting this option prevents the student from returning to the previous item unless 
the lesson is set to Menu mode since disabling the back button does not prevent the user 
from accessing a previous item by selecting it from the menu.  

4 - Feedback 
 
Feedback options apply to Fill in the Blanks and Multiple Choice items only. 
 
Three options are available from the Feedback menu: 
 

 

1. No Feedback 
Does not provide students with any indication if their answer is correct or incorrect. Once 
the answer is entered, the students are prompted to click next. 
 

2. Incorrect Answer Feedback 
Indicates if the answer was correct or incorrect only. Does not provide the correct answer.  
The information is displayed beside the next button: 
 

 

3. Full Feedback 
It is the default option. It indicates if the question was correct or not and displays the 
correct answer if the question was answered incorrectly. 
 

 
Correct answers are shown on a green background, underneath the student's answers.  
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The feedback options usually apply when the lesson is in practice mode. 
Feedback is not offered in a lessons placed in test mode unless the questions have no 
mark assigned. 

 

 

 
 
  

 
 

 
 
 
  
 
 
 
 
 
 
 
 


